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REELtime 
Digital Video Processing Software 

REELtime is a tool for creating video clips that can be used in multi
media presentations, or edited in programs such as Animator Pro and 
PhotoStyler. You can capture live video sequences and store them on 
your computer's hard disk in digital format. 

Grabbing single frames and converting them to the correct file format 
used to take hours. With REELtime this task can now be accom
plished in a matter of seconds.Using a presentation package like Ima
geQ from ImageNorth, you can add audio to the clip during your pre
sentation. 

REELtime operates under the Windows 3.1 software environment in 
combination with Cardinal Technologies' SNAPplus board. 

The input video signals can be Composite, S-Video or ROB at NTSC 
or PAL frequencies. These signals are input to the SNAPplus board, 
saved to hard disk in FLC or TOA format and incorporated into a 
variety of multimedia applications. 
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Introduction 

Manual Organization 

This manual is divided into five parts. 

Part I Getting Started ......... . .... page: 5 
Part II Capabilities .. ...... . ........ page: 9 
Part III Step-by-Step Instructions .... page: 29 
Part IV A Video Tutorial . . ........... page: 49 
Part V Applications ........... . .... page: 59 

In Part I you will find hardware requirements, how to install REELtime on your sys
tem and how to get started. 

In Part II we describe the capabilities of REEL time. We explain the functions of the 
commands in the menu bar and show you how to use them. 

In Part Ill we present a step-by-step instruction guide on how to execute the various 
functions of REELtime. 

In Part IV we discuss commonly used terms and we explain their meaning. 

In Part V we show you some examples on how to get the most out of REELtime. 

Throughout this text we will use terminology pertaining to the MS-DOS and Win
dows environment; we therefore assume that you possess a working knowledge of 
MS-DOS and Windows. 

4 REELtime User's Manual 

Part I 
Getting Started 
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Hardware Requirements 

The minimum system requirements for REELtirne are: 

CPU: 80386DX/33Mhz 
80486SX/25M hz 

RAM: 8Mb; 16Mb recommended 

Fixed Drive: 4Mb of free space 

Diskette Drive: 3.5" 1.44Mb 

SNAPplus Board: one 

Loading REELtime 

1. Make certain that you have Windows 3.1 installed. If this has not been done-do 
it now. 

2. Create a directory on your hard drive and call it REELtirne. 

Example: C:> md REELtime - ( Enter ) 

3. Copy all files on the REEL time diskette to the REELtirne directory; the assump
tion is to use drive A. 

Example: C:> copy a:*.* c:\REELtirne - ( Enter ) 

4. Go into Windows; double-click on the Program Manager icon. 

5. Click on NEW to create a new program group. 

6. In the Description field type: 
REELtime. You can leave the Group File field blank. 

7. Click on OK to create a new Windows folder called REELtime. 
8. With the REELtime folder open, click on NEW in the program manager win

dow to create a new program item. 

9. In the Description field type: 
REEL time. 

10. In the Command Line field type: 
c: \REEL time \REELtime.exe 

11. Click on OK to create a new program item. 

12. The REELtime mfa icon should now appear in the work group. 
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Quick Start 

You start REELtime from the Windows environment; proceed as follows: 

1§@•11 
Change to the directory where you installed Windows, i.e. 

CD:\WINDOWS ( Enter ) 

WIN/S ( Enter ) (We recommend starting Windows in the standard mode to 

avoid severe breaks in the video clips.) 

EJr.MS 
Make certain you have loaded REELtime properly 
and you have established a new work group. Your 
Program Manager window should display the RE
ELtime icon, which we are showing here. 

1§@-ii 
Connect a video source, such as a VCR, to the video input connector of the SNAP
plus board - supply video and connect a monitor to the VGA output. 

1§@•11 

Double click on Iii& and the 

REELtime picture will be displayed. 

Figure 1 - Component Hook-up 

You can wait for the REELtime picture to 
disappear or you can click on it, using the 
left mouse button. You will be left with a 
blank REELtime screen - you are now 

ready to use the Digital Video Processing Software. 
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Part II 
Capabilities 

In Part II of the User's Manual we explain the pull-down 
menus, what their functions are, how to access them and 
what they are used for. 

Chapter 1 

Chapter 2 

Chapter 3 

Contents 

The File Menu . . . . . . . . . . 11 

The Capture Menu . . . . . . . 19 

The Options Menu . . . . . . . 25 
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Chapter 1 
The File Menu 
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Part II - Chapter 1 

The File Menu 
Step-by-step instructions start on page: 31 

With the commands in the File menu you can: 

[I Open a file Ctr1+O 

U Set up the video parameters 
using Preferences 

Eisit Ctrt+Q 

t,bout REELtlme._ 

[I Exit the program 

[I Find the version number (About REELtime) 

Before you perform any operation in REELtime you have to adjust the video param
eters using the Preferences dialog box. Unless you set all levels properly images 
that you will save on disk may not be to your liking; i.e. you may see distortions on 
either side, or the picture quality is not good, etc. You should pay special attention 
to the Acquisition Window adjustments; see Section 1.1.4 on page 14. 

1 .1 Preferences 
See also page: 33 

In the Preference dialog box you can adjust image or picture quality, determine the 
video source, the video rate, and you can eliminate or reduce distortions on the in
coming video. 

1 .1.1 Scroll Bars 
See also page: 34 

The mouse is used to 
drag the scroll bars. 
With the scroll bars 
you can adjust the 
video parameters for 
optimum picture 
quality and range. 

The default settings 
are: 
Picture Adjust: 50 
Color Adjust: 75 
Video Input: Com
posite 
Video Rate: NTSC 
Video Source Name: 
Default 

- Preferencen. 

Video Source Name: ~ls_et_up_l _________ ~J Ii) 
Pidure Adjust - Color Adjust -

U II 111 
Bri Con Sat Hue Red Green Blue 

57 67 63 55 75 75 75 

Video lnpu1--- -----, 

® Composite O RGB Separate Sync 

Q ·s-Video O RGB Sync On Green 

~Acquisition Window -

Left: 134 li&·iO·.•.·.❖.•.·® 

Top: 19 \il-;·;f .•.•········•lif 

Right: 777 liJ·.·.·.···'··•l-•···#l·") 

Bonom: 259 li3·.··········-t-··'1W 

Video Rate- P>')/!···········J 
®[Nl'scj 1····.•.··;§tffi:··.:.:..·j 
0 PAL 1 .•. ) Dii:lilc:, ••••• j 

1··· •• •·@@, ••• •··I 
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1.1.2 Picture Adjust 1.1.3 Color Adjust 
See also page: 34 See also page: 34 

The four vertical scroll bars are used to 
fine-adjust Brightness, Contrast, Sat
uration (color) and Hue (tint.) More 
details will be available in the Video 
Tutorial , starting on page 53. 

The three vertical scroll bars are used to 
fine-adjust the Red, Green and Blue 
color levels of your incoming video. 
More details will be available in the 
Video Tutorial, starting on page 53. 

Picture Adjust 

ii!! 

Bri Con Sat Hue 

57 67 63 55 

1.1.4 Acquisition Window 
See also page: 35 

The proper adjustment of the Acquisition 
Window is a pre-requisite for obtaining a dis
tortion free input video picture. It should be 
the first adjustment you make before you cap
ture images. 

In the acquisition window you can adjust the 
raw video as it comes in from a video source, 
such as a VCR. As you examine this video you 
may notice distortions on either side and on 
the top and bottom of the video window. 
These distortions are inherent to video 

Color Adjust 

Red Green Blue 

75 75 75 

Acquisition Window 

Left: 134 1Jd:)'{l:::::::: ::!Ji3 

Top: 19 1,£Jt.i.1: ................. J$1 

Right: 777 fuiiJ-..,.,. ........ ·.··Lill@ 

Bottom: 259 EH ....... · .. .Llli) 

sources and the amount and intensity may vary from device to device. Moving the 
horizontal scroll bars in this dialog box will allow you to cut off these distortions 
on all sides of the window. 
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1.1 .5 Video Input 
See also page: 35 

Video input coming from a source can be: 

Composite low video quality, single cable terminating in an RCA plug~ 

S-Video good video quality, two conductor cable plus ground with a four pin 

mini-DIN connector.~ 

RGB highest video quality, four conductors plus ground, terminating in a 

BNC connector; (II) one for each conductor. 

More details will be available in the Video Tutorial, starting on page 
53 . 

1 .1 .6 Video Rate · 
See also page: 36 

Video rate refers to the type of video rate your device can supply. NTSC is common
ly used in the USA and Japan and PAL is used in Europe; see the Video Tutorial, 
starting on page 53. 

1.1.7 Video Source Name 
See also page: 36 

The intensities and strengths of video signals, generated by different sources, can 
vary a great deal. It is therefore imperative that the appropriate adjustments be made 
for each video source with which you intend to work. For example, you may employ 
several VCRs, Video Discs or Video Cameras as input devices. For each of these 
devices the video Prr.fcrcnccs 

parameters will have to be Video Source Name: l!m!l!ll! f i~~::~~~~;~~ r il~ r,;;:~==.~==;::=.PC~-v~c=R--------'-"'"'I 

enter a unique name in the 
Video Source Name box to identify the video source. Instead of having to make 
the adjustments again for the same video source you can simply recall these settings 
by the name you had previously assigned to that particular video source. 
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1.2 Open 

See also page: 39 

Open is used to display pre
viously saved (on hard 
disk) video files. A list of 
input file types is available 
in the List Files of Type 
box. 

1.2.1 List Files of Type 
See also page: 39 - Step 2 

Open hie 

The List Files of Type dialog box lists all cur
rently available input file types. 

1.2.2 Play Control Dialog Box 

See also page: 40 

16 

After you have opened a file the Play 
Control Dialog Box will pop up. The yel
low buttons control the movement of your 
recorded video, much the same way you 
control a VCR. 

The obvious functions are identi
fied in the picture. File info and 
Speed control will be explained 
in the next Sections. 

REELtime User's Manual 

1.2.3 The Info Dialog Box 

The Info Dialog Box displays the parameters 
associated with the file you are viewing. 

Filename 
This entry refers to the name of the file you are 
viewing. 

Path 
This entry shows the file path. 

Number of Frames 
This entry shows how many frames you had cap-
tured. 

File Size 
This entry shows the size of the file in bytes. 

Average Frame Size 

Part II - Chapter 1 

Flename : T.FLC 
Patti : c:lwlndows\system 

Number ot Frames : 15 

Fie sue : 2967% bytes 

Average Frame Size : 19786 bytes 

Resolution : 158 x 116 

~ 
~ 

This entry shows the average frame size - file size/number of frames=average 
frame size. 

Resolution 
This entry refers to the resolution of your captured video. A Small Frame will result 
in poorer resolution and a Large Frame will result in better resolution; (see page 
21.) 

1 .2.4 Speed Control 

The speed bar adjusts the playback speed of the current 
file. The number to the left represents the delay time be

tween eac rame; e 1gher the number, the slower the playback speed- the lower 
the number the faster the playback speed. 

The actual speed of playback varies depending on how much graphic infonnation 
is displayed in each frame and how much graphic information is changing between 
frames. Playback speed also depends on the speed of your computer and video card. 

I 1.3 Exit 
Exit will leave the REELtime program. 

I 1 .4 About REELtime I 
Clicking on this entry will display the version of the REELtime Digital Video Pro
cessing Software you are working with. 
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The Capture Menu 
Step-by-step instructions start on page: 45 

The commands in the Cap
ture menu are used to capture 
and save live video on your 
hard disk. 

You can: 

[F Capture video in a small 
frame. 

U Capture video in a large 
frame. 

I 2.1 Small Frame I 

:00 REELtime 
:ID ~apture 
j ~mall Frame (16Ox120) ... Ctrl+S 

.Large Frame (32Ox240) ... Ctrl+l 

The size of the small frame is approximately 160x120 pixels. A small frame occu
pies about 18 Kb of disk space. The resolution of a small frame is not as good as that 
of a large frame. If you want to store video frames with better resolution you should 
use the Large Frame command; see the next Section. 

Advantage: uses less disk space; higher frame rate (more frames/second) 
faster playback speed. 

Disadvantage: lower resolution. 

! 2.2 Large Frame 

The size of the large frame is approximately 320x240 pixels. A large frame occupies 
about 75 Kb of disk space. The resolution of a large frame is better than that of a 
small frame. If you want to store video frames with lower resolution you should use 
the Small Frame command; see the previous Section. 

Advantage: 
Disadvantage: 

higher resolution. 
uses more disk space; lower frame rate (less frames/second) 
slower playback speed. 
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2.3 The Capture Dialog Box 
See also page: 46 

The options in the Capture dialog 
box are the same whether you se
lect a small frame or a large frame 
in which to capture live video. 

2.3.1 File Types 

You can specify the file type, FLC 
or TGA, to be stored to disk. FLC 
files are stored in compressed for
mat, they therefore use less disk 
space than TGA files. TGA files 

FHeiype: IFLcme 00 
FIie.Harne: 1•.flc I 

0 
Dreeltlme 

l'.>ft.'.es: lllilc: 00 
frame Rate: /1!! lps I@ 
.,•c-·• ·.,,,,.,., •. ,.,0<,,CJ 
Number 01 fr3mes: L] 
fWi-i':'i h~dl l~sil 

are stored as is, they use up disk space but are easier to edit and the color resolution 
is much better than FLC files. Of course if you intend to export these files to other 
programs, such as Photostyler or Animator Pro, you have to make certain that you 
use the correct format Photostyler can process TGA files, while Animator Pro can 
process FLC files. 

FLC file names can be 8 characters long and TGA file names can be 4 characters 
long. 

2.3.2 File Name 

You can assign a unique file name to each video se
quence that you are recording; later on you can open 
the file by that name. 

2.3.3 Frame Rate 

The frame playback rate on a VCR is 30 fps (frames 
per second.) This means that in one second 30 individ
ual frames are shown on your monitor. The pauses be
tween frames (at that rate) can not be discerned by the 
human eye; the motion appears very smooth. 

The frame rate of capture in REEL time can vary from 
15 fps down to .1 fps. 

File Iype: jFLCfile 

File l-!ame: I K.flc 

alone.fie 
fox.fie 

frame Rate: 15 fps 

:~;-;:::·:·,:·,:-J :-(--::·: 10 fps 

Number of Fr 5 fps 

[Ill Ii:~~~~ 
.lf s 

At 15fps we can capture every 2nd frame; 30/15 = 2; playback is smooth. 
At 5fps we can capture every 6th frame; 30/5 = 6 
At lfps we can capture every 30th frame; 30/1 = 30 
At . lfps we can capture every 300th frame; 30/.1 = 300; playback is jerky. 

IM 
I 

i. 

T 
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As we can see a video, captured at 15fps, will play back much smoother than one 
captured at .lfps. 
So why do we want to capture video at .lfps? 
At .lfps we can capture more video (a longer sequence of the tape) than we can at 
15fps. However, at .lfps we skip more frames than we would at 15fps and therefore 
the playback looks jerky when captured at . lfps. 

2.3.4 Starting Frame No. 

This function is active only when you record a TGA file. You can assign starting 
numbers to the frames of your sequence. 

2.3.5 Number of Frames 

You can specify how many frames you want to capture; 
the default is 30. The maximum number of frames you 
can capture, using the small frame window, is 457; us
ing the large frame window you can capture a maxi
mum of 104 frames - the minimum is one frame. 

frame Rate: ~j1s_f_p_s -~';t-~J 

•To be able to capture the maximum number of frames you need 16Mb of RAM• 
•ff not enough disk space is available, nothing will be saved• 

2.3.6 Set 

When all the settings in the Capture Dialog Box are to your satisfaction click on 

I <*~rn I and they will become current. 

2.3.7 Start 

Click on [:@1MiH] to start the capture process. As soon as you initiate Start the entire 

capture sequence gets placed into RAM (Random Access Memory) and from there 
it gets written to disk. When you capture video at .1 fps you will notice that the mes
sage below the video window Grabbingframes to RAM stays up for some time be
fore it informs you that it is saving to file - Frame 0. 

2.3.8 Cancel 

Click on l@m@.~(l to cancel the entire operation and you will return to the main 

REELtime window. 

REELtime User's Manual 23 



Part II - Chapter 2 

Chapter3 
The Options Menu 

3.1 Grayscale Palette ...................... 27 
3.2 Color Optimized Palette . . . . . . . . . . . . . . . . 27 
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The Options Menu 
See also Step 2 - page: 45 

Qptions 
..1 GrnyScr1le P-..1lc1te CtrltG 

The commands in the Op
tions Menu are used to se
lect the video capture pal
ettes. The Options Menu is 
effective on FLC files only. 

.Qolor Optimized Palette Ctrl+C 

You can: 

[F Capture video in Grayscale. 

[F Capture video in Color. 

I 3.1 Grayscale Palette 

REELtime 

Grayscale is the Default setting. Once you invoke Grayscale Palette the video will 
be captured in grayscale. This mode has to be set before you do any capture. 

When saving to TGA files, the grayscale palette is simulated by removing the satu
ration from the incoming video. This will work for composite video ands-video, 
but will not work for RGB video. REELtime cannot save RGB video as grayscale 
for TGA files. 

I 3.2 Color Optimized Palette I 
Once you invoke Color Optimized Palette the video will be captured in color. This 
mode has to be set before you do any capture. 

When saving to an FLC file, REELtime will convert the digitized video from 
16-bits (65,536 colors) down to 8-bits (256 colors). REELtime has been designed 
for optimum efficiency; it looks at the colors used in the entire clip, and selects 256 
colors to represent all of these colors. If a grayscale palette is selected, these 256 
colors will be converted to 256 shades of gray. 
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Part III 
A Step-by-Step 

Instruction Guide 

Part III of the User's Manual is a step-by-step instruction 
guide to show you how you can display captured video 
files, set the video parameters to obtain good video 
frames, and how to capture video sequences on your hard 
disk. 

The steps you must follow have been clearly called out. 

Chapter 4 

Chapter 5 

Chapter 6 

Contents 

Setting-up Preferences . . . . . . . . . . 31 

How to Open a Video File . . . . . . . 37 

How to Capture Video . . . . . . . . . . 43 
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Chapter4 
Setting -up Preferences 
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Ending the Preferences Session . . . . . . . . . . . . . . . . 36 
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Setting-up Preferences 
For a general discussion see page: 13 

Before you attempt to capture video you should make the various adjustments to get 
a good picture, using the Preferences dialog box. 

EiM·II 
Connect a video source to the input of your SNAPplus board, connect a monitor and 
supply a video signal; see page 8. 

l§A•tl 
Start Windows in standard mode, i.e. WIN/s. 

GM·h 
Open REELtime, i.e. double click on £ 
GM·ii 
In the Menu Bar click on: 
File 

You will get the File pull-down menu, 
pictured to the right. 

1§14 .. i 
From the File pull-down menu se
lect: 
Preferences 

REELtime User's Manual 

.l:;apture .Qptions 

ereferences... Ctrl+P 

Elsit Ctrl+Q 

6bout REELtime ... 

.Qpen... Ctrl+O 

Preferences ... Ctrl+P 

E!!it Ctrl+Q 

About REELtime ... 
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I§@,@ Adjust the Video Scroll Bar 
See also Section 1.1.1 - page: 13 

Preferences With the mouse you 
can drag the scroll bar 
or you can click on the 
arrows to move the 
scroll bar one step at a 
time. Place the cursor 
over the arrow and 
hold the left mouse 
key for continuous 
travel. When the scroll 
bar is in the center 

Video Source Name: ~ls_et---'up'--1 _________ _____, 

Picture Adjust Color Adjust Aaiuisitian Window 

1111111 
Left: 134 li)ru.f,·.·· .•. • •• j.jj 

Top: 19 l··d ···•:j••····:::::::::l:iij 

Righi: 777 1$:m:.,:::lMl•!J 

Bottom:259 w2i:.fdjj) 
Bri Con Sat Hue Red Green Blue 
57 67 63 55 75 75 75 

position its level is at Video Input Video Rate l:·i:·:·:·:91,en 
l==#i&iW::l%I 
HWJffff•ml 
!:>>':fillfif'::::•1 

50, or mid point; ® Composite O RGB Separate Sync 

please observe the OS-Video O RGB Sync On Green 

®lfii'sg 
•PAL 

changing numbers be-
low as the scroll bar moves. 

1§1§,@ Adjust the Picture Quality 

Move the Bri (Brightness) scroll bar up for a brighter picture. 
Move the Con (Contrast) scroll bar up or down to obtain the 
contrast you prefer. Move the Sat (Saturation) scroll bar 
down for a less colorful picture (color adjust) and move the 
Hue (Hue or Tint) scroll bar up or down for the tint you pre
fer. 

When an RGB signal is input to the SNAPplus card Satura
tion and Hue can not be adjusted. 

Adjust all levels to your preference. 

fi@-l§d Adjust the Colors 

The three vertical scroll bars adjust the Red, Green and Blue 
color levels of your incoming video. Moving the scroll bars 
up will increase the respective color levels. 

Adjust all colors to your preference. 

Picture Adjust 

!Iii !Iii 

Bri Con Snt Hue 

57 67 63 55 

Color Adjust 

iii 
i 

Red Green Blue 

75 75 75 
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Ei@-fi Adjust the Acquisition Window 
See also Section 1.1.4 -page: 14 

Distortions on either side of the video window 
can be reduced or eliminated by moving the re
spective scroll bar. 

For exam pie: take a look at the top of the video 
scene coming from a VCR. You can observe 
distinct distortions in this area. Using the Top 
scroll bar move it or click on one of the arrows 
to move it a step at a time, you will observe that 
the picture moves in the vertical direction, elim
inating these distortions. You can do the same 
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Acquisition Window 

Left: 134 lifll=:=:·:j m:=':i:·:::.jjj 

Top: 19 1-dwt··PY::·=::=];iij 

Right: 777 1$1·••;::·:·.::·=:-:;::jX']!E 

Bottom: 2 59 1·=:• .c§,::,::@i:=:!;:::::Jja) 

for any distortions you may have on any side of ~---------~ 
the video window by moving the appropriate 
scroll bar. 

Please keep in mind that you may have to balance the left and the right, the top and 
the bottom to achieve the desired results. It may take a little practice to get a final , 
good picture. If these distortions have not been completely eliminated or reduced 
to your satisfaction when you open a video window, go back to the Preference dia
log box and adjust them again. 

Click on Reset if you want to go back to the settings you started out with . 

1§@•1·1 Select Video Input 
See also Section 1.1.5 -page: 15 

Place your mouse cursor over the ra
dio button and click on the type of 
video input you are. providing. 

Video Input 

® Composite O RGB Separate Sync 

Please check in the instruction OS-Video O RGB Sync On Green 
manual of the video equipment you 
are using for the type of video out-
put signal it provides. 
It Most consumer VCRs supply composite video. 
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1§1§,@ 8elect the Video Rate 
See also Section 1.1.6 -page: 15 

Place your mouse cursorover the radio button and click on the 
type of video rate your device can supply. 

l§@•li•• Enter a Video Source Name 
See also Section 1.1.7 - page: 15 

Video Rate 

®!NTSCI . 
=-·-···-···-····· 

OPAL 

After you have made all the adjustments you can enter a unique name in the Video 
Source Name box. 
1. Click on this arrow to display a list of existing file names. 

2. Click on the name you ¥ 
want to use and it will be 
inserted as the video 
source name. In this ex -
ample we have Default, 
NEC PC-VCR and 
test. 

3. If you want to create a 

' 

new name bring the cursor over the Video Source Name box and enter the new 
name. 
11 Please observe the changing setting of the scroll bars as you recall various 
Video Source Names - to match the settings of the video source that is being 
recalled. 

l§i§•••• Ending the Preferences Session 

Click on 1:)!i!)\!!:l:IIIJ!i\\f\l and the Preferences you have set will be saved under the 

name you had assigned in the Video Source Name. 

If you plan to use other Preferences set-ups you can then easily recall each of them 
by that name. 

Click on -,r-::1:1-::·:,-.• -:,-1.m-::''._!_iff-~!:I and you erase the highlighted Video Source Name from 

~~------ -
Click on l[§J.lfi&JI to cancel the Preferences set-up session-no changes will 

have been made. 

Click on ,,,,:m:::wm&-:t::~Mtl if you want to make temporary changes without saving the 

adjustments. 
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How to Open a Video File 
Fora general discussion see Section 1.2 page: 16 

You must have a video file stored on your hard disk before you can 
open it. 

1§§••• 
In the Menu Bar click on: 
File. 

You will get the File pull-down menu 
pictured to the right. 

l§G-t• 
From the File pull
down menu select: 
Open. 

You will get the 
Open File dialog 
box, shown to the 
right. 

II 

.Capture Qptions .t!elp 

frcfcrcnccs ... Ctrl+P 

E,sit Ctrl t O 

Open rile 

Click on this arrow to get a list of available input file formats; at this time only FLC 
files can be opened. 

EM·& 
-this Click on a file name, in our example: alone.fie 

name will be placed in the File Name box. ~ 
Click on OK and the image file will be display ed(see 
picture on page 40) 

You may also double click on a file name a nd the 
image file will be displayed at once. 

File Ji11me: 

Im 
.... alone.He 

lox.lie 

If the files appear in the File Name box, then choose one and: 

-~Step4 I 
otherwise continue with Step 3a. 

REELtime User's Manual 

I 
:,-. ,... 

7 

39 



Part III - Chapter 5 

5.1 If you can't find the files. 

EA·EW 
If you are pointing to a directory which does not con
tain the files you want to display, or if the File Name 
box is empty (see picture to the right), make sure that 
you are pointing to the correct disk drive and the cor
rect directory. 

To get there: 

1. Double click on the disk drive (in our example: 
drive C) containing the directory (in our example: 
REEL time) under which you had captured the file 
you want to play. 

2. Double click on the directory name i.e. REELtime. 
The file names will now be displayed under the 

· File Name box. 

5.2 Operating the Play Dialog Box. 

1§§•1@ See also Section 1.2.2 - page: 16 

Fileliame: 

j•.t1c 

Qirectories : 

c:\ 

CJ images 
c::J londma.rk 
CJ midisolt 
CJ mouse 
Cl pstyler 
Cl PZP 

Cl •dms 

File Harne: 

ID 
alone.lie 
fox.fie 

--- -------- - - ---

Click on [W to reverse the direction of the -

video by one frame at a time. 

Click on O to stop the play; click on play and 

the video will start from the beginning of these
quence. 

Click on la to pause; click on play will re

sume the sequence. 

Click on Im to start play. 

Al ONE FLC 

DODD • 
Click on ~ to forward the direction of the 

video by one frame at a time. 

Speed • =1•E..-I ""l!!!!!!!!""'!!'""\!""!!1'""!!!!1=•1 

Click on II@~==::==:d to get information about the frame. 

Click on ~ iB,•+:i:,,,1, •• ,~;-~;,., .. ,ij,iJ to vary the play back speed. 

Click on liifoW.i.JHj to close the play dialog box. 
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I 5.3 About REELtime 

Click on About REELtime and the 
version number of the software will be 
displayed, see below. 
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_Qpen ... 

£references ... Ctrl+P 

Eisit Ctrl+Q 

I 5.4 Exit 
Click on Exit to end the REELtime session. 
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How to Capture Video 
For a general discussion see page: 21 

1§€1•11 
Make sure you have a video source hooked up to the SNAPplus board (see page 8.) 

l§M•tl 
Decide whether you want to capture the video in Grayscale or Color. 

l§M•H 
Click on the Options 
Menu. file .(;apture 

1§€i•E@ Grayscale 

Click on Grayscale Pal-
ette~ 
The system is now set to capture video in grayscale. 

1DnFstep41 

1§€i•Eib Color 
After you have chosen Options click on Color Optimized Palette. 
The system is now set to capture video in color. 

6€1·1• 
In the Menu Bar click on: 
Capture 

You will get the Capture pull
down menu pictured to the 
right. 

ijc:j ... j 

~ REELtime 
!Im !:;apture • , , 
' S.mall Frame (160x120) ... Ctrl+S 

Large Frame [320x2~0J... Ctrl+L 

Choose either a Small Frame or a Large Frame. The resulting Capture Dialog Box 
will be the same for either frame, exceptthatthe video window size will be different. 
Since the steps are the same we will discuss the procedure for a Small Frame only. 
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Eii9··• 
Click on Small Frame and you 
will get the Capture Dialog Box, 
pictured to the right. 

See also Section 2.3 - page: 22 

1§@,fi 
Click on rF-11-e r=-yp_e_: 'T='G""A""fi""1e""s ==a 
File Type 
to get a L __ nm•• 
listing of file types and make your 
choice; see page 22 for details. 

FLCfile 

EiA-1-i 
Bring the mouse cursor into this bo

1
x and type a unique 

name to identify the video sequence you are about to cap
ture. 

l§i4•0 
Click on Frame Rate to get a list of rates available -
make your choice by clicking on the one you wish to 
employ; see page 22 for details. 

EA·ii•• 
Enter the number of NymberofFrames: ~ 

frames you wish to cap-
ture in your video sequence; see page 23 for details. 

Ale lype: ii& ~-- j;ij 
Ale H..,., I·-"' 1 

Jllr. c~tem 

0c:'\ 
O,wlndow, 

lb system 
0<:ard1 

C 

Dr!fes; f-c Efl 
frame Rate:~ 
%•::,., ,-,,,,,,,,,."c=i 
N111nberofFrames: ~ 

IM~Jl~ 

FIie ,Harne: I •.flc 

frame Rate: 15 fps 

10fps 
5 fps 
1 fps 
.5fps 
.2 fps 
.1 fps 

I 

' 
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Eii4•1il 
Click on Set - the settings will now become cUITent. • 

Note: 
If you change your mind click on Cancel and the pull- ,;::::::-i r::::::-i r::::=i 

~~~ down window will disappear. 

Ei9•1r4 
Click on Start - recording will now begin. The se- --i 
quences, starting from the time you clicked on Start r==-i r::::::-i r::::=i 

~~~ will now be recorded to your hard disk. 

Please observe the status messages 
below the video window as the pro
gram grabs and saves the video se
quences to disk. 
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Part IV 
A Video Tutorial 
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A Video Tutorial 

7.1 AVI 
(Audio Video Interleaved) A product developed by Microsoft which synchronizes 
motion video and audio without the use of specialized hardware. This could be used 
to create Talking Head presentations, display animation sequences and to present 
multimedia slide shows. 

7.2 Brightness 
Brightness is the ability to intensify colors on the screen. A good brightness control 
allows the brightness of the image to be increased or decreased without changing 
the image's color attributes. 

7.3 Compression 
A digital process that allows data to be stored or transferred using less than the nor
mal number of bits. DVI is an example of hardware compression and AVI is an ex
ample of software compression. 

7.4 Contrast 
Contrast is the difference between light and dark. The higher the contrast a monitor 
is capable of, the crisper the image appears. 

7.5 DVI 
Digital Video Interactive is a proprietary technology developed by Intel (and li
censed by IBM) for full motion video at a high level of compression (hardware.) 
This technology will be supported by Windows using MCI commands. 

7.6 FLIC File 

7.7 Flicker 
Flicker is the perception of light changing intensity. On CRT monitors it is created 
by the phosphor lighting up as it is struck by the electron beam and then fading when 
the beam is turned off. The longer the phosphor glows, the less likely is it that the 
image will flicker. Flicker is influenced by the monitor's refresh rate. The slower 
the vertical scanning frequency the more flicker. 

Flicker is related to the similarities in the characteristics of the phosphorous and the 
human eye. Light emitted by the phosphorous on the screen's surface decays rapid
ly. Similarly, light initiated by chemical reactions in the human eye decays (at a 
slower rate), crating the impression of light even after the light source is removed. 
When an image is refreshed before the chemical reaction of the eye has decayed, 
then the eye perceives the image as a continuous steady image. When the image is 
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refreshed after the chemical reaction of the eye has decayed, then the eye will per
ceive a flickering image. The point at which the eye perceives a flicker is called the 
flicker threshold. 
If you open and close your eyes very rapidly for a few seconds you can create flicker 
with your vision. While your eyes are open they are exposed to light and when you 
close them the light disappears. It is the same principle on a CRT screen. 
Flicker causes eye strain and headaches. It is more noticeable when using graphical 
user interfaces (GUI's) and graphical applications. The user's peripheral vision no
tices it more on monitors over 14". 
To avoid flicker vertical scanning frequencies of 79 Hz or higher should be used for 
resolutions of 1024x768 and 640x480 resolutions. Vertical scanning frequencies of 
70 Hz or higher is a must for users working with graphical applications as well as 
Windows applications because of the white background which makes flicker more 
noticeable. 

7.8 MCI 
Media Controllnterface is a high level control software that provides a device inde
pendent interface to multimedia devices and media files. MCI includes a command 
message interface and a command-string interface. This interface is supported by 
both IBM and Microsoft. 

7.9 Monitors - Grayscale . . . 
Greyscale monitors display up to 256 levels of grey. Greyscale 1s achieved by vana
tions of the luminance value of white light from black to white. 

19" 1280x1024 and down 

21" 1600x1280 and down 

7.1 o Monitors - Interlaced, Non-interlaced and Multiscan 
These terms refer to the method used to scan the screen horizontally. Some high res
olution monitors have too low of a horizontal scanning frequency to permit the dis
play of all their pixels without flicker. These monitors use a scanning method called 
interlacing. 
Interlacing breaks the image into two fields, scanning all the even horizontal lines, 
and then alternating, scanning all the odd horizontal lines. This is the lower cost 
method of vertical scanning and the trade off is an increase in flicker. 
Interlacing works very well in cases such as television that displays scenes, compos
ite, changing images. However, in text and graphic applications, horizontal lines 
will flicker because the displayed static image is refreshed below the flicker thresh
old frequency. 
To minimize flicker interlaced CRT monitors use long persistent phosphors since 
they glow longer than standard phosphors. Although long persistent phosphors 
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glow longer, they are not as bright as normal persistent phosphors. In addition, long 
persistent phosphors may cause lingering images (ghosts) when an image is re
moved from the screen, i.e. when the cursor is moved using a mouse. 
Non-interlaced monitors scan every line sequentially from top to bottom. As op
posed to the every-other-row approach of interlacing, non-interlaced monitors 
draw the complete image in one pass. Such monitors are significantly more expen
sive, but produce flicker-free video in high resolution modes. 
Multiscan or multiple frequency monitors can adjust to any frequency up to, and 
in some cases, beyond its stated maximum. As each video resolution comes with 
a defined set of horizontal and vertical scanning frequencies, a multiple-frequency 
monitor synchronizes to the particulars of a wide range of video modes. 

7.11 Monitor Sizes 
Low resolution applications, such as DOS based word processing generally use 13" 
and 14" monitors. CAD applications, graphic user interfaces (GUI's) and desktop 
publishing applications requiring very sharp crisp images use 17", 19", 20" and 25" 
monitors. 

As a general rule of thumb, the following minimum resolutions should be used with 
the corresponding size monitor. 

14" 800x600 and down 

16" 1024x768 and down 

17'' 1024x768and down 

7.12 Palette 
· A card's palette size is determined by the maximum number of colors it can create. 
An adapter's palette size is directly determined by the amount of memory on the 
card. In Windows, a palette is a data structure defining the colors used in a bitmap 
image. 

7.13 Pixel 
A single point of an image. A screen's resolution is commonly referred to in pixels. 

7.14 Resolution 
A monitor displays images by breaking them down into very small raster elements 
called pixels (picture elements), which are the smallest information building blocks 
of a display image. On color monitors each pixel is made up of one or more colors; 
blue, green and red. The size ofa pixel is measured in dots per inch ( dpi.) The small
er the pixel, the more pixels can be placed in a horizontal row. The smaller the pixel 
the finer the resolution and therefore the sharper the display image. 
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A monitor with a resolution of 640x480 has 640pixels in each horizontal row and 
480 horizontal rows. By multiplying those numbers, i.e. 640x480, you get 
307,200,the total number of pixels the screen can display. Therefore an in image 
consisting of 320x200 pixels (64,000 pixels per image) is very coarse, while an 
image of 1280x1024 pixels (1,310,720 pixels per image) is very fine. 
The maximum resolution of a monitor is determined by the size of the pixels ( dpi), 
the horizontal scanning frequency and the width of the monitor. Assuming the same 
horizontal scanning frequency and the the same size of pixels, an image displayed 
on a 14 " monitor with a 640x480 resolution looks smoother and finer than when 
displayed on a 21" monitor with a 640x480 resolution because the dpi or dot density 
is higher on a 14" monitor. The formula for figuring the dots per inch of a monitor 
is to divide the maximum number of pixels in the horizontal direction by the hori
zontal screen dimension in inches i.e. 640/14 = 45.71 dpi. 
Resolution does not describe the quality or sharpness of the image displayed by the . 
monitor. It is only the capability, one limited by the signal from the video controller, 
to address a number of pixels. Therefore, resolution figures should not be used as 
a measure of image quality but of compatibility( whether the monitor will work with 
specific signals from the video controller.) The actual sharpness of an image is in
fluenced by a combination of factors, including the electronics of the monitor, the 
CRT (Cathode Ray Tube), the mechanical construction of the monitor and even the 
size of the screen. 

7.15 Scanning Frequencies -
The horizontal scanning frequency, measured in KHz, determines the maximum 
amount of information that can be placed on one horizontal line during one scan of 
thatline. Forinstance, a monitor with a horizontal scanning frequency of 31.5 KHz 
can place more information on a horizontal line than a monitor with a 15.75 KHz 
horizontal scanning frequency. 
The vertical scanning frequency, measured in Hz, is referred to as the refresh rate. 
It determines how fast the monitor can scan from top to bottom of the screen to dis
play the image. A monitor with a 60 Hz vertical scanning rate will refresh the entire 
screen sixty times per second. 
Vertical and horizontal scanning frequencies are interdependent. If the resolution 
is to stay the same when the vertical scanning frequency is increased the horizontal 
scanning frequency must increase also. For instance: suppose you have a 640x480 
monitor with a 60 Hz vertical scanning frequency and a 31.5 KHz horizontal scan
ning frequency. If the vertical scanning frequency is increased to 72 Hz then the hor
izontal scanning frequency must increase to approximately 36 KHz. 
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7.16 Scanning Images 
A monitor can not display any video without a video controller (also known as a 
Graphics Card or a VGA Adapter.) A video controller stores the entire image in the 
form of pixels in its RAM (Random Access Memory) and then sends the informa
tion to the monitor. Although the video controller can store all the pixels, the moni
tor can display only one pixel at a time. Therefore the video controller must send 
each pixel to the monitor one at a time (serially.) 

The video controller begins displaying the image by sending all the pixels for the 
first line to the monitor causing the guns (part of the monitor) to send a beam of elec
trons that sweep across the top row of the screen from left to right. After all the pixels 
for the first row have been sent and the electron beam reaches the right hand side 
of the screen the video controller sends a special signal, called the horizontal sync 
(synchronization) pulse to tell the gun to begin a new row. The beam is turned off, 
the gun moved a row down and to the left hand side of the screen and then swept 
across the screen again from left to right. (This is the same pattern we use when we 
read.) 

This sweeping or scanning process continues until the gun reaches the bottom of the 
screen. The video controller the issues a vertical sync pulse to the monitor instruct
ing it to start a new image on the first line. The electron beam is then turned off while 
the gun is aimed at the top of the screen again where it begins scanning the entire 
screen again. This process is referred to as horizontal scanning and vertical scan
ning. Scanning rates are measured in units of Hertz. One Hertz (Hz) is one cycle 
per second and one thousand Hertz is one thousand cycles per second or one kilo 
Hertz (KHz.) 

Images are formed during the scanning process by turning the electron beams on 
and off as the gun sweeps across the screen. The beam is turned of where no image 
is to appear. When the beam is turned on it strikes the phosphor, causing it to glow. 
The glowing phosphor is seen as a spot oflight on the front of the monitor;(the gun 
and the phosphor is behind the screen, on the inside of the monitor.) Since the phos
phor glow fades quickly, the screen must be continuously scanned to sustain the 
image. 

7.17 Sync Signals 
Horizontal and vertical sync signals from the video controller tel the circuitry in the 
monitor when and where to aim the gun. All the sync characteristics of the monitor 
must match the same characteristics in the video controller. 

Multiscanning or multisyncing monitors are preferred because they instantly tune 
in a wide range of video modes and resolutions as long as the scanning range of the 
video controller does not exceed the range of the monitor. Better super VGA con
trollers feature multiscanning. 
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7.18 Sync Signal Types 
Analog sync signals may be combined (one signal for both horizontal and vertical 
syncs on one line) or separate (two signals, one for each of the two syncs.) 

Composite Sync 

A method that combines the horizontal and vertical sync on one input line. 

RGB Separate Sync 

Separate sync sends the horizontal and vertical sync positioning signals from the 
video controller to the monitor on their own separate line;They typically use 5 BNC 
connectors. 

RGB Sync on Green 
A method that combines the horizontal and vertical sync on one video input lines; 
normally green in color monitors. 

7.19 WAVE File 
A Microsoft standard file format for storing waveform audio data. WA VE files have 
a .Wav filename extension. 
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REEL time is designed as a tool for creating video clips that can be used in multime
dia presentations, or edited in programs like Animator Pro and PhotoStyler. What 
used to take hours by grabbing single frames and converting to the correct file for
mat can now be done in a matter of seconds with REELtime. Using a presentation 
package like ImageQ from ImageNorth, you can add audio to the clip during your 
presentation. 

Editing your REELtime clips 

After you have saved your video clip to an FLC file, you can take the clip into Auto
desk Animator Pro to edit it. Under Animator Pro you can discard frames, adjust 
colors and add animated objects, backgrounds or text to the clip. 

If you save the video clip to TGA files, you can use any of several image processing 
packages to edit the frames and finally assemble the frames into an FLC file using 
Animator Pro. Using combinations of programs like Aldus Photos tyler and Gallery 
Effects, you can apply stunning effects to your clips such as a clear sky changing 
to stormy weather, or a water-colored person coming to life over a series of frames. 

Using REELtime clips in a presentation 

After you have saved a video clip to an FLC file you can use the file as part ofa m ul
timedia presentation. Using a presentation package such as ImageQ or RSC Inter
Active, the FLC file can be simply inserted into a script along with still images, live 
video, or audio files to create an exciting show on the PC. The FLC file could also 
be converted to an AVI file in Microsoft's Video for Windows package, allowing 
the audio to be synchronized to the video clip. 
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